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About this guide

This guide provides setup and troubleshooting information for the HP Z Workstation series. It includes
these topics:

Guide topics

Locating HP resources on page 1

Workstation features on page 7

Setting up the workstation on page 20

Setting up and restoring Windows 7 on page 32

Setting up and restoring Windows 8 on page 39

Setting up and restoring Linux on page 44

Diagnostics and Minor Troubleshooting on page 51

Routine Care on page 57

TIP: If you do not find what you are looking for in this guide:

— Find technical details in the Maintenance and Service Guide for your workstation at
http://www.hp.com/support/workstation_manuals.

— View component installation videos at http://www.hp.com/go/sml.

— See additional information on your workstation at http://www.hp.com/go/workstations.
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1 Locating HP resources

This section provides information on the following resources for your HP workstation:

Topics

Product information on page 2

● Technical specifications

● HP Cool Tools

● Regulatory information

● Accessories

● System board

● Serial number, Certificate of Authenticity, and Genuine
Microsoft Label

Support on page 3

● Product support

● HP Support Assistant

● Warranty information

Product documentation on page 4

● HP and third-party documentation, white papers

● Product notifications

● Technical specifications (QuickSpecs)

● Customer Advisories, Security Bulletins, Notices

Product diagnostics on page 5

● HP Vision Diagnostics

● HP PC Hardware Diagnostics

● Audible beeps and LED code definitions

● POST error codes

Product updates on page 6

● Driver and BIOS updates

● Operating systems
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Product information
Table 1-1  Product information

Topic Location

Technical specifications Go to www.hp.com/go/quickspecs. In the left pane, select your region and then
select Workstations.

HP Cool Tools (Windows® 7
only)

Most HP workstations with the Windows 7 operating system are preloaded with tools
that may enhance system performance and with additional software that is not
automatically installed during first boot. To access these applications:

● Click the HP Cool Tools icon on the desktop, or

● Open the HP Cool Tools folder by selecting Start > All Programs > HP >
HP Cool Tools.

To learn more about these applications, click HP Cool Tools—Learn More.

To install or launch the applications, click the appropriate application icon.

Additional information is located in the Maintenance and Service Guide for your
workstation on the web at http://www.hp.com/support/workstation_manuals/.

Regulatory information Refer to the Safety & Regulatory Information guide for product regulatory information.
You can also refer to the regulatory label on the workstation chassis.

Accessories For complete and current information on supported accessories and components, see
http://www.hp.com/go/workstations.

System board A diagram of the system board is located on the inside of the side access panel
(tower and desktop configurations) or on the inside of the chassis (all-in-one
configurations). Additional information is located in the Maintenance and Service
Guide for your workstation on the web at http://www.hp.com/support/
workstation_manuals/.

Serial number, Certificate of
Authenticity (COA) labels, and
Genuine Microsoft Label (GML) (if
applicable)

Serial number labels are on the top or back panel (tower and desktop
configurations). The COA (Windows 7) label and GML (Windows 8) are typically
located near the serial number label. Some workstations have this label on the bottom
panel.

Linux For information on running Linux on HP workstations, go to http://www.hp.com/
linux/, then select Linux on Workstations from the list on the left.

2 Chapter 1   Locating HP resources

http://www.hp.com/support/workstation_manuals/
http://www.hp.com/go/workstations
http://www.hp.com/support/workstation_manuals/
http://www.hp.com/support/workstation_manuals/
http://www.hp.com/linux/
http://www.hp.com/linux/


Support
Table 1-2  Support

Topic Location

Product support For U.S. support, go to http://www.hp.com/go/contactHP.

For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

Here you can:

● Chat online with an HP technician

● Obtain email support

● Find support telephone numbers

● Locate an HP service center

HP Support
Assistant
(Windows 7
only)

HP Support Assistant is an HP application that helps you maintain the performance of your workstation
and resolve problems through automated updates and tune-ups, built-in diagnostics, and guided
assistance.

To access HP Support Assistant, double-click the HP Support Assistant icon on your desktop.

NOTE: HP Support Assistant is pre-installed on select HP workstations running Windows 7. HP
Support Assistant is not available on workstations running Linux or Windows 8.

Warranty
information

To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, see http://h20219.www2.hp.com/services/us/en/warranty/
carepack-overview.html. HP Care Pack Services offer upgraded service levels to extend and expand a
standard product warranty.

You can find the expressly provided HP Limited Warranty applicable to your product in the start menu
on your PC and/or in the CD/DVD provided in the box. For some countries/regions, a printed HP
Limited Warranty is provided in the box. In countries/regions where the warranty is not provided in
printed format, you may request a printed copy from http://www.hp.com/go/orderdocuments or write
to:

● North America: Hewlett Packard, MS POD, 11311 Chinden Blvd, Boise, ID 83714, USA

● Europe, Middle East, Africa: Hewlett-Packard, POD, Via G. Di Vittorio, 9, 20063, Cernusco/
Naviglio (MI), Italy

● Asia Pacific: Hewlett-Packard, POD, P.O. Box 200, Alexandra Post Office, Singapore 911507

Please include your product number, warranty period (found on your serial number label), name, and
postal address.
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Product documentation
Table 1-3  Product documentation

Topic Location

HP user documentation, white
papers, and third-party
documentation

For the latest online documentation, go to http://www.hp.com/support/
workstation_manuals. These include this User Guide and the Maintenance and
Service Guide.

Removal and replacement videos To learn how to remove and replace workstation components, go to
http://www.hp.com/go/sml.

Product notifications Subscriber's Choice is an HP program that allows you to sign up to receive driver
and software alerts, proactive change notifications (PCNs), the HP newsletter,
customer advisories, and more. Sign up at www.hp.com/united-states/subscribe/
gateway/?jumpid=go/subscribe-gate1.

Technical specifications The Product Bulletin contains QuickSpecs for HP Workstations. QuickSpecs include
information about the operating system, power supply, memory, CPU, and many
other system components. To access the QuickSpecs, see http://www.hp.com/go/
quickspecs/.

Customer Advisories, Security
Bulletins, and Notices

To find advisories, bulletins, and notices:

1. See http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. From the Resources section, select See more....

4. Use the scroll bar to select Customer Advisories, Customer Bulletins, or
Customer Notices.
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Product diagnostics
Table 1-4  Product diagnostics

Topic Location

Windows 7 Diagnostics tools:

● HP Vision Diagnostics
(Z420, Z620, Z820)

● HP PC Hardware
Diagnostics (Z220 SFF,
Z220 CMT)

The HP Vision Diagnostics utility is pre-installed on select Windows 7 workstations.

The HP PC Hardware Diagnostics tool is pre-installed on Windows 7 workstations.

Additional information is located in the Maintenance and Service Guide for your
workstation on the web at http://www.hp.com/support/workstation_manuals/.

Windows 8 Diagnostics tools:

● HP Vision Diagnostics
(Z420, Z620, Z820)

● HP PC Hardware
Diagnostics (Z220 SFF,
Z220 CMT)

The HP Vision Diagnostics utility is pre-installed on select Windows 8 workstations.

The HP PC Hardware Diagnostics tool is pre-installed on Windows 8 workstations.

Additional information is located in the Maintenance and Service Guide for your
workstation on the web at http://www.hp.com/support/workstation_manuals/.

Audible beep and LED code
definitions

Refer to the workstation Maintenance and Service Guide for your workstation at
http://www.hp.com/support/workstation_manuals.

POST error codes Refer to the workstation Maintenance and Service Guide for your workstation at
http://www.hp.com/support/workstation_manuals.
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Product updates
Table 1-5  Product updates

Topic Location

Driver and BIOS updates See http://www.hp.com/go/workstationsupport to verify that you have the latest
drivers for the workstation.

To determine the current workstation BIOS on your workstation, follow these steps
during system power up:

1. Power on the workstation, and press Esc during boot up.

2. Press F10 to enter the F10 Setup utility.

3. Go to File > System Information. Note the BIOS version and date and
compare it with the BIOS versions that appear on the HP website.

For Windows 7, you can also find the BIOS version number, as follows:

1. Go to Start > All Programs > Accessories > System Tools > System
Information.

2. In the right pane, find the line with BIOS Version/Date.

3. Note the BIOS version and date and compare it with the versions that appear
on the HP website.

In Windows 8, you can also find the BIOS version number, as follows:

1. Point to the upper-right or lower-right corner of the Start screen to display the
charms.

2. Click Settings > Change PC Settings.

Operating systems For additional information, on:

● Operating systems supported on HP workstations, go to http://www.hp.com/
go/wsos.

● Windows operating systems, go to http://www.microsoft.com/support.

● Linux operating systems, go to http://www.hp.com/linux.
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2 Workstation features

For complete and current information on supported accessories and components for your workstation,
see http://partsurfer.hp.com.

Topics

HP Z220 SFF Workstation components on page 8

HP Z220 CMT Workstation components on page 10

HP Z420 Workstation components on page 12

HP Z620 Workstation components on page 14

HP Z820 Workstation components on page 16

Product specifications on page 18
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HP Z220 SFF Workstation components
This section describes the HP Z220 Small Form Factor (SFF) Workstation components.

For complete and current information on supported accessories and components for the computer, see
http://partsurfer.hp.com.

Z220 SFF Workstation front panel

Figure 2-1  Front panel components

Table 2-1  Component description

1  Optical drive 5  
Optional media card reader (shown)
or optional second hard disk drive

2 Power button 6
Hard drive or optical drive activity
light

3 USB 2.0 ports (4, black) 7 Headphones connector

4
Microphone or headphones connector
(software selectable, default mode is
microphone)
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Z220 SFF Workstation rear panel

Figure 2-2  Rear panel components

Table 2-2  Component descriptions

1 RJ–45 network connector 7 DisplayPort (DP)

2 Serial port 8 VGA (monitor) (blue)

3 PS/2 mouse connector (green) 9
PS/2 keyboard connector
(purple)

4  Power cord connector 10 Audio line-out connector (green)

5 USB 2.0 ports (2) (back) 11 Audio line-in connector (blue)

6 USB 3.0 ports (4) (blue)
NOTE: The labels for the rear panel connectors use

industry-standard icons and colors.

NOTE: The DP and VGA ports are not supported when the system is configured with Intel® Xeon E3-12x0 v2 processors. Also, if a discrete graphics

card is installed, these ports are disabled by default.

NOTE: Simultaneous usage of integrated Intel HD graphics and discrete graphics cards (in order to drive more than two displays) can be enabled using

the Computer (F10) Setup Utility. However, HP recommends using only discrete graphics cards when attaching three or more displays.
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HP Z220 CMT Workstation components
This section describes the HP Z220 Convertible Mini Tower (CMT) Workstation components.

For complete and current information on supported accessories and components for the computer, see
http://partsurfer.hp.com.

HP Z220 CMT Workstation front panel

Figure 2-3  Front panel components

Table 2-3  Component descriptions

1  Optical drive 5 USB 3.0 ports (2) (blue)

2 Power button 6 Headphone connector

3 Hard drive activity light 7 Microphone connector

4 USB 2.0 ports (1) (black) 8
1394a FireWire® connector (optional
and plugged unless configured)
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HP Z220 CMT Workstation rear panel

Figure 2-4  Rear panel components

Table 2-4  Component descriptions

1  Power cord connector 9  Power supply Built-In Self Test (BIST) LED

2 PS/2 keyboard connector (purple) 10 PS/2 mouse connector (green)

3 DVI-I connector 11  Universal chassis clamp opening

4 Display Port (DP) connector 12  Cable lock slot

5 USB 2.0 ports (4) (black) 13  Padlock loop

6 USB 3.0 ports (2) (blue) 14 RJ-45 network connector

7 Microphone connector (pink) 15 Audio line-in connector (blue)

8 Audio line-out connector (green)
NOTE: The labels for the rear panel connectors use industry-

standard icons and colors.

NOTE: The DP and DVI-I ports are not supported when the system is configured with Intel Xeon E3-12x0 v2 processors. Also, if a discrete graphics card

is installed these ports are disabled by default.

NOTE: Simultaneous usage of integrated Intel HD graphics and discrete graphics cards (in order to drive more than two displays) can be enabled using

the Computer (F10) Setup Utility. However, HP recommends using only discrete graphics cards when attaching three or more displays.
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HP Z420 Workstation components

HP Z420 Workstation front panel 

Figure 2-5  Front panel components

Table 2-5  Component descriptions

1  Optical drive 5 USB 3.0 ports (2, blue)

2 Power button 6 Headphone connector

3 Hard drive activity light 7 Microphone connector

4 USB 2.0 port (1, black) 8
IEEE–1394a FireWire connector
(optional and plugged unless
configured)
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HP Z420 Workstation rear panel 

Figure 2-6  Rear panel components

Table 2-6  Component descriptions

1  
Power supply Built-In Self Test
(BIST) LED

9 Audio line-out connector (green)

2  Universal chassis clamp opening 10 Microphone connector (pink)

3 PS/2 mouse connector (green) 11
AMT-enabled RJ-45 network
connector (orange)

4 USB 2.0 ports (4, black) 12 USB 3.0 ports (2, blue)

5  Security slot 13
IEEE-1394a FireWire connector
(white)

6  Padlock loop 14
PS/2 keyboard connector
(purple)

7 Audio line-in connector (blue) 15 Rear power button

8  Graphics card connector 16  Power cord connector
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HP Z620 Workstation components

HP Z620 Workstation front panel 

Figure 2-7  Front panel components

Table 2-7  Component descriptions

1  Optical drive 5 USB 3.0 ports (2, blue)

2 Power button 6 Headphone connector

3 Hard drive activity light 7 Microphone connector

4 USB 2.0 port (black) 8 IEEE–1394a FireWire connector

14 Chapter 2   Workstation features



HP Z620 Workstation rear panel 

Figure 2-8  Rear panel components

Table 2-8  Component descriptions

1  Power cord connector 8 Audio line-out connector (green)

2 PS/2 mouse connector (green) 9 Microphone connector (pink)

3 USB 2.0 ports (4, black) 10 USB 3.0 ports (2, blue)

4
RJ-45 network connectors (orange)

Bottom connector is AMT enabled
11 IEEE-1394a FireWire connector (white)

5 Audio line-in connector (blue) 12 PS/2 keyboard connector (purple)

6  Graphics card connector 13 Rear power button

7  Security slot 14  
Power supply Built-In Self Test (BIST)
LED
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HP Z820 Workstation components

HP Z820 Workstation front panel 

Figure 2-9  Front panel components

Table 2-9  Component descriptions

1  Optical drive 5 USB 3.0 ports (2, blue)

2 Power button 6 Headphone connector

3 Hard drive activity light 7 Microphone connector

4 USB 2.0 port (1, black) 8 IEEE–1394a FireWire connector
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HP Z820 Workstation rear panel 

Figure 2-10  Rear panel components

Table 2-10  Component descriptions

1  Power cord connector 9 USB 3.0 ports (2, blue)

2 PS/2 mouse connector (green) 10 USB 2.0 ports (4, black)

3 Audio line-in connector (blue) 11 Audio line-out connector (green)

4
RJ-45 network connectors (2, orange)

Top connector is AMT enabled
12 Microphone connector (pink)

5 IEEE-1394a FireWire connector (white) 13 PS/2 keyboard connector (purple)

6  Security slot 14 Rear power button

7  Graphics card connector(s) 15  
Power supply Built-In Self Test (BIST)
LED

8 Serial connector (teal blue)    
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Product specifications

Workstation weights and dimensions

Characteristic
HP Z220

SFF
HP Z220

CMT
HP Z420 HP Z620 HP Z820

Weight

Standard
configuration

7.5 kg
(16.53 lb.)

11.6 kg
(25.57 lb)

13.2 kg
(29.10 lb)

17.9 kg
(39.46 lb)

26.6 kg
(58.64 lb)

Minimum
configuration

6.6 kg
(14.55 lb)

10.6 kg
(23.37 lb)

12.5 kg
(27.56 lb)

15.5 kg
(34.17 lb)

24.0 kg
(52.91 lb)

Maximum
configuration

8.4 kg
(18.52 lb)

14.7 kg
(32.41 lb)

17.7 kg
(39.02 lb)

22.6 kg
(49.82 lb)

32.0 kg
(70.55 lb)

Chassis dimensions

Tower configuration

Height
33.8 cm
(13.3 in)

44.8 cm
(17.6 in)

44.76 cm
(17.62 in)

44.45 cm
(17.50 in)

44.4 cm
(17.5 in)

Width
10.0 cm
(3.95 in)

17.8 cm
(7.0 in)

17.78 cm
(7.00 in)

17.15 cm
(6.75 in)

20.3 cm
(8.0 in)

Depth
38.1 cm
(15.0 in)

45.4 cm
(17.9 in)

44.50 cm
(17.53 in)

46.48 cm
(18.30 in)

52.5 cm
(20.7 in)

Chassis dimensions

Converted desktop
configuration

Height
10.0 cm
(3.95 in)

17.8 cm
(7.0 in)

17.78 cm
(7.00 in)

17.15 cm
(6.75 in)

20.3 cm
(8.0 in)

Width
33.8 cm
(13.3 in)

44.8 cm
(17.6 in)

44.76 cm
(17.62 in)

44.45 cm
(17.50 in)

44.4 cm
(17.5 in)

Depth
38.1 cm
(15.0 in)

45.4 cm
(17.9 in)

44.50 cm
(17.53 in)

46.48 cm
(18.30 in)

52.5 cm
(20.7 in)
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Environmental specifications

Table 2-11  HP Workstation environmental specifications

Characteristic HP Z220 SFF, Z220 CMT, Z420, Z620, and Z820 Workstations

Temperature

Operating: 5°C to 35°C (40°F to 95°F)

Non-operating: -40°C to 60°C (-40°F to 140°F)

NOTE: Derate by 1°C (1.8°F) for every 305 m (1,000 ft) altitude over 1,524 m (5,000 ft).

Humidity
Operating: 8% to 85% relative humidity, non-condensing

Non-operating: 8% to 90% relative humidity, non-condensing

Altitude
Operating: 0 to 3,048 m (10,000 ft)

Non-operating: 0 to 9,144 m (30,000 ft)

Shock

Operating: ½-sine: 40g, 2-3ms

Non-operating:

● ½-sine: 160 cm/s, 2-3ms (~100g)

● square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not indicate repetitive shock events.

Vibration

Operating Random: 0.5g (rms), 5-300 Hz

Non-Operating: random: 2.0g (rms), 10-500 Hz

NOTE: Values do not indicate continuous vibration.
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3 Setting up the workstation

This chapter describes how to set up your workstation.

Topics

Ensuring proper ventilation on page 20

Setup procedures on page 22

Adding monitors on page 23

Converting to desktop configuration (Z220 CMT and Z420)
on page 29

Ensuring proper ventilation
Proper ventilation for the system is important for workstation operation. Follow these guidelines:

● Operate the workstation on a sturdy, level surface.

● Provide at least 15.24 cm (6 inches) of clearance at the front and back of the workstation.
(Workstation models vary.)

Figure 3-1  Proper workstation ventilation
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● Ensure that the ambient air temperature falls within the environmental specifications listed in this
document.

NOTE: The ambient upper limit of 35°C (95°F) only good up to 1524 m (5000 ft) elevation.
There is a 1°C (33.8°F) per 304.8 m (1000 ft) derating above 1524 m (5000 ft). So, at 3,048 m
(10,000 ft), the upper ambient air temperature limit is 30°C (86°F).

● For cabinet installation, ensure adequate cabinet ventilation and ensure that the ambient
temperature within the cabinet does not exceed specified limits.

● Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air
intakes, as shown in the following figure.

Figure 3-2  Proper workstation placement
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Setup procedures
WARNING! To reduce the risk of electric shock or damage to your equipment, observe these
practices:

• Plug the power cord into an AC outlet that is easily accessible.

• Disconnect power from the computer by unplugging the power cord from the AC outlet (not by
unplugging the power cord from the computer).

• Plug the cord into a grounded (earthed) three-pin outlet. Do not disable the power cord grounding
pin (for example, by attaching a two-pin adapter). The grounding pin is an important safety feature.

NOTE: An HP Z820 Workstation with a 1125 W power supply might require more power than the
typical office environment can supply. For details, see the Site Preparation Guide for the workstation at
http://www.hp.com/support/workstation_manuals.

To set up the workstation:

1. Connect the mouse, keyboard, and power cord to the workstation.

2. Connect the monitor to the workstation.

3. Plug the workstation power cord and monitor power cord into an AC outlet.

4. Connect other peripheral components (such as a printer) according to the instructions included
with the device.

5. Connect an Ethernet cable to the computer and to a network router or LAN device.

Figure 3-3  Connecting the workstation
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Adding monitors

Planning for additional monitors

All graphics cards provided with HP Z series Workstations support two simultaneous display monitors
(see Connecting and configuring monitors on page 27). Cards that support more than two monitors
are available. The process for adding monitors depends on your graphics card(s) and the type and
number of monitors you add.

Use this process to plan for adding more monitors.

1. Assess your monitor needs:

● Determine how many monitors you require.

● Determine the kind of graphics performance you want.

● Note the type of graphics connector used by each monitor. HP provides graphics cards with
DisplayPort (DP) and DVI interfaces, but you can use adapters and third-party cards to
interface to other graphics formats, including DVI-I, HDMI, or VGA.

TIP: Some adapters for older legacy hardware may cost more than others. You may want
to compare the cost of acquiring adapters with the cost of getting a newer monitor that
doesn't need adapters.

2. Determine if you need additional graphics cards:

● Consult the graphics card documentation to determine how many monitors you can connect
to the card.

You may need to acquire adapters to match the card output to the monitor connector. (See
Matching graphics cards to monitor connectors on page 25.)

● If necessary, plan to acquire a new graphics card to drive additional monitors.

● The maximum number of monitors that a graphics card supports depends on the card. Most
cards provide outputs for two monitors. Some provide three or four outputs.
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NOTE: Monitors with resolutions above 1920 x 1200 pixels at 60 Hz require a graphics
card with either Dual Link DVI (DL-DVI) or DisplayPort output. To get native resolution with
DVI, you must use a DL-DVI cable, not standard DVI-I or DVI-D cables.

HP computers do not support all graphics cards. Make sure a new graphics card is
supported before purchasing it. See Finding supported graphics cards on page 25.

Many graphics cards provide more than two monitor outputs but limit you to using only two
at a time. Consult the graphics card documentation or look up information on the card
according to the procedure in Finding supported graphics cards on page 25.

Some graphics cards support multiple monitors by multiplexing the monitor signal across
multiple outputs. This might reduce graphics performance. Consult the graphics card
documentation or look up information on the card according to the procedure in Finding
supported graphics cards on page 25.

Make sure the card outputs match the input required by the monitors. (See Identifying monitor
connection requirements on page 26.)

The different models of HP Z series Workstations have different limits on the mechanical size,
data speed, and power available for additional graphics cards. In addition, the usual
practical limit for graphics cards is two per computer. Refer to the Maintenance and Service
Guide for expansion card slot identification to make sure a new graphics card will work for
your computer.

3. If you want to add a new graphics card or cards:

a. Determine which graphics card HP supports that will best fit your needs in terms of number of
monitors, compatibility with the monitors you plan to use, and performance. See Finding
supported graphics cards on page 25.

b. Make sure you have the correct drivers for the card.

c. Install the graphics card according to the video instructions for your workstation at
http://www.hp.com/go/sml.

d. Configure the monitor. For details, refer to Microsoft® Help or to http://www.microsoft.com,
or to your Linux Help website.

TIP: To simplify troubleshooting of possible problems, enable the monitors one at a time:
enable the first monitor and make sure it works properly before enabling the next monitor.
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Finding supported graphics cards

To find information about graphics cards supported for your workstation:

1. Go to http://www.hp.com/go/quickspecs.

2. In the left navigation bar under QuickSpecs, click on your country, then select Workstations.

3. Choose your model to view the specifications.

4. Click on the link for Technical Specifications-Graphics. This displays expanded technical
information for supported graphics cards, including how many monitors the card supports,
connectors, power consumption, drivers, and other details.

Matching graphics cards to monitor connectors

The following table describes monitor configuration scenarios.

Graphics card interface
connector

Monitor connector

VGA DVI
Dual Link

DVI
DisplayPort

(DP)
HDMI

DISPLAYPORT DisplayPort to
VGA adapter

(sold
separately)

DP to DVI
adapter

DP to DL DVI
adapter

DP cable
DP to HDMI

adapter

DVI—I (WHITE)
DVI to VGA

adapter or DVI-
I cable

DVI-D cable DL DVI cable N/A N/A

VGA (BLUE)

No adapter
required

DVI-I to VGA
adapter is
required

N/A N/A N/A

DMS-59

DMS-59 to
VGA adapter

DMS-59 to
DVI adapter

N/A
DMS-59 to DP

adapter
N/A

* This interface is a dual-monitor graphics interface card that supports two VGA or two DVI monitors.

NOTE: HP graphics cards include monitor cable adapters unless otherwise indicated.

DisplayPort cards have the highest performance; VGA graphics cards have the lowest.
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Identifying monitor connection requirements

The following are various scenarios for connecting monitors. ( See Matching graphics cards to monitor
connectors on page 25 for more information about the different graphic cards):

● Graphics card with DisplayPort output — If the graphics card has four DisplayPort outputs,
you can connect a monitor to each connector. Use the proper adapters if required.

● Graphics card with DVI output — If you have a PCIe graphics card with two DVI outputs,
you can connect a monitor to each connector. Use the proper adapters if required.

NOTE: Models that have only one DVI port always have a second graphics output option
(Display Port or VGA).

Many graphics cards provide more than two monitor outputs but limit you to using only two at a
time. Consult the graphics card documentation or look up information on the card according to the
procedure in Matching graphics cards to monitor connectors on page 25

On a system with two DVI connections, port number 1 provides the primary display, which is
where the BIOS POST screen appears after a system boot. (Usually this is the lower of the two
outputs. Only one card is used during BIOS POST, although you can change this in the BIOS
settings.)

● Graphics card with VGA and DL-DVI output — If the workstation does not have a PCIe
graphics card, but has one or more SVGA and/or DL-DVI outputs, you can connect a monitor to
each output.

● Graphics card with DMS-59 output — If the workstation has a PCIe graphics card with a
DMS-59 output receptacle, use the appropriate adapter to connect your monitor.

Adapters are available to connect the DMS-59 output to two DVI or two VGA monitors.
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Connecting and configuring monitors

NOTE: The graphic cards that HP supports typically allow at least two monitors, as shown in this
section; some supported cards allow more monitors. Refer to the graphics card documentation for
details.

1. Connect the monitor cable adapters (1) (if required) to the workstation, then connect the
appropriate monitor cables to the adapters (2) or directly to the graphics card.

Figure 3-4  Connecting the cables to the workstation

2. Connect the other ends of the graphics cables to the monitors.

Figure 3-5  Connecting cables to the monitors

3. Connect one end of the monitor power cord to the monitor and the other end to a grounded
power outlet.

4. Configure the monitor. For details, refer to Microsoft Help or to http://www.microsoft.com, or to
your Linux Help or website.
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Using a third-party graphics configuration utility

Third-party graphics cards may include a monitor configuration utility. Upon installation, this utility is
integrated into Windows. You can select the utility and use it to configure multiple monitors with your
workstation.

Refer to your graphics card documentation for details.

NOTE: Some third-party configuration utilities require that you enable the monitors in Windows
before using the configuration tool. Refer to your graphics card documentation for more information.

NOTE: Monitor configuration utilities are also often available on the HP support website.

Customizing the monitor display (Windows)

You can manually select or change the monitor model, refresh rates, screen resolution, color settings,
font sizes, and power management settings.

● To change display settings in Windows 7, right-click a blank area on the desktop, and then click
Screen Resolution.

● To change display settings in Windows 8, point to the upper-right or lower-left corner of the Start
screen to display the charms, and then click Settings > Control Panel > Appearance and
Personalization > Adjust Screen Resolution.

● For Windows 8, you can also change the display settings by pointing to the upper-right or lower-
left corner of the Start screen to display the Charms menu, and then clicking Search > Settings,
typing resolution in the Settings search field, and clicking Adjust Screen Resolution.

For more information about customizing your monitor display, refer to:

● Online documentation provided with the graphics controller utility

● Documentation included with your monitor
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Converting to desktop configuration (Z220 CMT and
Z420)

This workstation can be operated in mini-tower or desktop configuration. Follow these steps to convert
to desktop configuration:

NOTE: See a video of this task at http://www.hp.com/go/sml.

1. Prepare the workstation for component installation.

2. Remove the front bezel from the workstation.

3. Press gently on the edges of the optical drive bay filler panel and remove it from the front bezel.

Figure 3-6  Removing the ODD bay filler panel

4. Rotate the filler panel 90 degrees to a horizontal position.

5. Align the slots in the filler panel frame with the tabs in the front bezel. Press the optical drive filler
panel back into the front bezel until it snaps into place.

Figure 3-7  Installing the ODD bay filler panel

Converting to desktop configuration (Z220 CMT and Z420) 29

http://www.hp.com/go/sml


6. On the back of the front bezel, squeeze the HP logo mounting tabs (1) and press the logo outward
(2).

Figure 3-8  Rotating the HP logo

Rotate the HP logo 90 degrees counterclockwise, then release the logo and press it back into
place.

7. Remove the EMI filler panels and optical disk drive from the chassis.

8. Rotate the EMI filler panels and optical drive 90 degrees, then reinstall them.

Figure 3-9  Reinstalling the optical drive

9. Replace the front bezel and the side access panel.
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Installing optional components
Depending on the workstation model, additional components (such as memory, hard drives, optical
drives, PCIe cards, or second processor) can be installed on your workstation.

● To view component installation videos, go to http://www.hp.com/go/sml.

● For installation guidelines and technical information, refer to the Maintenance and Service Guide
for your workstation at http://www.hp.com/support/workstation_manuals.

Security
Some HP workstations have a lock on the side access panel. The key for this lock is shipped attached to
the back panel of the workstation chassis.

Additional security features reduce the risk of theft and warn of chassis intrusion. Refer to the
Maintenance and Service Guide for your workstation at http://www.hp.com/support/
workstation_manuals for information about additional hardware and software security features
available for your system.

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.

For information about recycling HP components or products, see http://www.hp.com/go/recycle.
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4 Setting up and restoring Windows
7

This chapter provides setup and update information for the Windows 7 operating system. It includes
these topics:

Topics

Setting up the Windows 7 operating system on page 32

Restoring and recovering in Windows 7 on page 33

NOTE: After you set up the operating system, you should make sure the latest BIOS, drivers, and
software updates are installed on the workstation. Refer to the chapter on updating the workstation.

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

Setting up the Windows 7 operating system
CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the
software.

For complete installation and configuration instructions, go to http://windows.microsoft.com/en-US/
windows7/help. Additional information is available in the online help tool after you successfully install
the operating system.

Installing or upgrading device drivers

You must install the appropriate device drivers before you install hardware devices. Follow the
installation instructions that came with the device. For optimum performance, your operating system
must have the most recent updates, patches, and software fixes. For additional driver and software
update information, refer to the chapter on updating the workstation.
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Transferring files and settings

The Windows operating system offers data migration tools that help you select and transfer files and
data from one Windows-based computer to another.

For information on these tools, go to http://www.microsoft.com.

Restoring and recovering in Windows 7
To protect your information from loss or damage, back up your personal data files. Refer to the
operating system or backup utility documentation for instructions on making backup copies of your data
files.

To protect the software from loss or damage, keep a backup copy of all system software, applications,
and related files stored on the hard drive.

If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from support. To
obtain the support telephone number for your region, see http://www.hp.com/support/contactHP.
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System Restore

If you have a problem that might be due to software that you installed on your computer, use System
Restore to return the computer to a previous restore point. You can also set restore points manually.

NOTE: Always use this System Restore procedure before you use the System Recovery feature.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen
instructions.

To add restore points manually:

1. Close all open programs.

2. Click the Start button, right-click Computer, click Properties, and then click System
protection.

3. Under Protection Settings, select the disk for which you want to create a restore point.

4. Click Create, and then follow the on-screen instructions.
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System Recovery

WARNING! This procedure will delete all user information. To prevent loss of information, be sure to
back up all user information so you can restore it after recovery.

Always use the System Restore procedure before you use the System Recovery program. See System
Restore on page 34.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed after
purchase.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

You must choose one of the following methods to perform a System Recovery:

● Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 35 or System Recovery when Windows is not responding on page 36.

● Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. To create recovery media, see System
recovery using recovery media on page 36.

System Recovery when Windows is responding

CAUTION: System Recovery deletes all data and programs you have created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.

NOTE: In some cases, you must use recovery media for this procedure. To create this media, follow
the instructions in Creating recovery media on page 37.

If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery.

1. Turn off the computer.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Turn on the computer.

4. When Windows has loaded, click the Start button, click All Programs, click Security and
Protection, click Recovery Manager, and then click Recovery Manager. If prompted,
click Yes to allow the program to continue.

5. Under I need help immediately, click System Recovery.

6. Select Yes, and then click Next. Your computer restarts.

NOTE: If your system does not detect a recovery partition, it prompts you to insert recovery
media that you have created. Insert the first disc or the USB flash drive, select Yes, and then click
Next to restart the computer. If you are using discs, insert the next disc when prompted.
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7. When the computer restarts, you will see the Recovery Manager welcome screen again. Under I
need help immediately, click System Recovery. If you are prompted to back up your files,
and you have not done so, select Back up your files first (recommended), and then click
Next. Otherwise, select Recover without backing up your files, and then click Next.

8. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

9. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding

CAUTION: System Recovery deletes all data and programs you have created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.

4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files… message appears on the screen.

5. Under I need help immediately, click System Recovery.

6. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

7. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

8. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System recovery using recovery media

You should create a set of recovery media, either a set of DVDs or a USB flash drive, from the recovery
image stored on your hard disk drive. This image contains the operating system and software program
files that were originally installed on your computer at the factory. You can create only one set of
recovery media for your computer, and the media can be used only with this computer. Store the
recovery media in a safe place.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

● To create recovery discs, your computer must have a DVD writer, and you must use only high-
quality blank DVD+R or DVD-R discs.

NOTE: You cannot use DVD+RW, DVD-RW, DVD+RW DL, DVD-RW DL, DVD+R DL, or DVD-R
DL discs to create recovery discs.

● You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.
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● If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

● The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs needed
to make the set. If you are using a USB flash drive, the program will tell you the size of the drive
required to store all the data (minimum of 8 GB).

NOTE: The process of creating recovery media is lengthy. You can quit the process at any time.
The next time you initiate the process, it resumes where it left off.

Creating recovery media

To create recovery discs:

1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click HP Recovery Media Creation. If prompted, click Yes to allow the
program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc as you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:

NOTE: You must use a flash drive with a capacity of at least 8 GB.

1. Close all open programs.

2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much storage
is required to create the recovery drive. If the USB flash drive does not have enough storage
capacity, it will appear grayed out, and you must replace it with a larger USB flash drive. Click
Next.

NOTE: Recovery Media Creation formats the flash drive, deleting any files on it.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.
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Using recovery media

CAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.

To create recovery media, see System recovery using recovery media on page 36.

To perform a System Recovery using recovery media:

1. If using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

2. If the computer is not responding, press and hold the power button for approximately 5 seconds or
until the computer turns off.

or

Click the Start button, and then click Shut Down.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer.

5. Press Esc as the computer is powering on to see the startup menu. Use the arrow keys to select the
boot menu and press Enter. Use the arrow keys to select the location where the recovery media is
inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under I need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9. When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.
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5 Setting up and restoring Windows
8

This chapter provides setup and update information for the Windows 8 operating system. It includes
these topics:

Topics

Additional information on page 39

Backup and recovery in Windows 8 on page 40

NOTE: After you set up the operating system, you should make sure that the latest BIOS, drivers, and
software updates are installed on the workstation. Refer to the chapter on updating the workstation.

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

Additional information
Additional information is available in the online help after you customize the operating system.

Setting up the Windows 8 operating system

The first time you turn on the computer you can customize the operating system. If you are connected to
the Internet, Microsoft activates your operating system. This process takes about 15 to 30 minutes.
Carefully read and follow the instructions on the screen.

We recommend that you register your computer with HP; so you can receive important software
updates, facilitate support questions, and sign up for special offers. You can register your computer
with HP using the Register with HP app on the Start screen.

CAUTION: After the initial setup process has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during this process may damage the software
that runs the computer or prevent its proper installation.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type help, and then select Help and Support.
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Downloading Windows 8 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

Run Windows Update as soon as possible after you set up your computer.

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings > Windows Update.

3. Run Windows Update monthly thereafter.

Backup and recovery in Windows 8
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive, create system repair media, or create system restore points. In case of
system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type help, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. The system repair media is used to start up (boot) the computer and repair the
operating system in case of system instability or failure. Your initial and subsequent backups allow you
to restore your data and settings if a failure occurs.

Type backup on the Start screen, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive, or a network drive.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Backup templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Windows Backup and Restore:
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NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image, or create system
repair media.

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

● The F11 recovery tools: You can use the F11 recovery tools to recover your original hard drive
image. The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created, you must purchase Windows 8 operating system media to reboot the
computer and repair the operating system. For additional information, see Using HP Windows 8
restore media (purchased separately) on page 43.

Using the Windows recovery tools

Recover information you previously backed up:

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. For
additional information go to Help and Support. From the Start screen, type help, and then select Help
and Support.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition:

From the Start screen, type e, and then click Windows Explorer.

– or –

From the Start screen, type c, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system media and the Driver
Recovery media (both purchased separately). For additional information, see Using HP Windows
8 restore media (purchased separately) on page 43.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer after
Windows has loaded, and then press and hold Shift while clicking Restart.

NOTE: If the computer fails to boot to Windows after several attempts, the system will boot to
the Windows Recovery Environment by default.
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4. Select Troubleshoot, select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type help, and then select Help
and Support.

Using F11 recovery tools

CAUTION: Using F11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The F11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using F11:

1. If possible, back up all personal files.

2. Restart the computer, and then press esc while the company logo is displayed. The computer
Startup Menu displays.

3. Press F11 to select the System Recovery option.

4. Choose your keyboard localization.

5. On the Choose an option menu, select Troubleshoot.

6. On the Troubleshoot menu, choose either Refresh your PC to repair the OS or Reset your PC
to completely reinstall the OS.

7. Follow the on-screen instructions.

NOTE: If the F11 System Recovery does not start, you must recover your operating system and
programs using the Windows 8 Restore Media (purchased separately). For additional information,
see Using HP Windows 8 restore media (purchased separately) on page 43.
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Using HP Windows 8 restore media (purchased separately)

To order HP Windows 8 restore media, go to http://www.hp.com/support, select your country or
region, and follow the on-screen instructions. You can also order the media by calling support.

CAUTION: Using HP Windows 8 restore media completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using HP Windows 8 restore media:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Insert the Windows 8 OS DVD.

3. Restart the computer, and then follow the instructions provided with the Windows 8 operating
system media to install the operating system.

4. When prompted, press any keyboard key.

5. Follow the on-screen instructions.

After the operating system install is completed:

1. Remove the Windows 8 operating system media, and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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6 Setting up and restoring Linux

HP offers a variety of Linux solutions for HP workstation customers:

● HP certifies and supports Red Hat Enterprise Linux (RHEL) on HP workstations.

● HP certifies and supports SUSE® Linux Enterprise Desktop (SLED) on HP workstations.

● HP offers a SLED 11 preload on some Z series Workstations.

This chapter describes how to set up and restore the Linux® operating system. It includes these topics:

Topics

HP Installer Kit for Linux (HPIKL) on page 45

Setting up Red Hat Enterprise Linux on page 45

Setting up SUSE Linux Enterprise Desktop (SLED) on page 47

Proprietary graphics drivers on page 48

NOTE: After you set up the operating system, make sure the latest BIOS, drivers, and software
updates are installed. Refer to the chapter on updating the workstation.

CAUTION: Do not add optional hardware or third-party devices to the workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

HP Linux Support Matrix
Not all release streams are supported on particular platforms. To find out which streams are supported
on your workstation. refer to the Linux certification and support matrix:

1. Go to http://www.hp.com/linux.

2. In the Platforms tab, select HP Workstations.

3. Select Certification Matrix.

4. Go to the Red Hat or SUSE tab.
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HP Installer Kit for Linux (HPIKL)
The HP Installer Kit for Linux helps users install certified versions of RHEL or SLED on HP workstations. It
is available as an operating system option on all HP workstations. The kit:

● Contains tested drivers that augment and/or replace those found in RHEL or SLED to enable
proper use and behavior on HP workstations.

● Does not include Linux operating system, which must be purchased separately from Red Hat or
SUSE. To view supported configurations and operating systems, go to http://www.hp.com/
support/linux_hardware_matrix.

The HPIKL option includes a FreeDOS preload. This operating system option accommodates those who
have a customized Linux distribution, or who have a licensed version of RHEL or SLED and would like to
install the HP-recommended driver additions.

The kit also can be downloaded:

1. Go to http://www.hp.com/support/workstation_swdrivers.

2. Select your workstation model.

3. Select the desired operating system.

4. Select your software/driver language, and then click the Software quick jump link.

5. Click the Obtain Software link for the appropriate package (typically the most recent revision).

6. Click I Agree to accept the terms of the license agreement.

7. Download the software ISO image and save it on a disc. This disk is your HP driver disc.

Setting up Red Hat Enterprise Linux
HP Z series Workstations are certified and supported on RHEL streams appropriate to the hardware
technology.

● For details of RHEL support for a particular platform, see the Hardware Support Matrix for HP
Linux Workstations at http://www.hp.com/support/linux_hardware_matrix.

● For information about Red Hat certifications on HP workstations, go to
https://hardware.redhat.com.
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HPIKL driver disc

Recent versions of Red Hat Linux typically require only driver updates with minor fixes to support HP
workstations. These releases can usually be supported with the HPIKL driver disc, which can be used as
a post-installation utility for the standard Red Hat Linux install.

After you complete the standard Red Hat install and restart the system, a Red Hat first-boot utility runs.
After you specify a number of settings (such as the security level, time and date, root password, user
accounts), the utility lets you to load additional disc.

The driver disc is used during this phase. All content added by HP is in the /HP directory on the disc.
You can use it to build your own image or to browse the HP content.

NOTE: Some installations may encounter problems if they are performed with a DisplayPort
connection to the monitor. This is because the default drivers that the OS installers use do not support
DisplayPort functionality. If you experience problems, try overriding the monitor choice for DisplayPort
during the start of the install and using the VESA driver instead. You can then set up the DisplayPort
monitor later.

Installing with the HP Red Hat Linux driver disc

1. If you do not have the appropriate HP driver disc for a supported stream, create one (see HP
Installer Kit for Linux (HPIKL) on page 45.

2. Install the operating system using the optical media included in the Red Hat Linux box-set.

3. If you have a Red Hat driver disk for the OS version you are installing, enter linux dd on the
initial install splash screen, and then press Enter.

4. When asked if you have a driver disc, select Yes. Place the Red Hat driver disc in the drive, and
select the appropriate drive:hd[abcd]. Continue the normal installation.

5. After successfully installing the operating system, reboot the workstation.

● RHEL 5: the Red Hat Setup Agent (also known as first-boot) automatically starts. At the
Additional DVDs screen, insert your HP driver disc and select Install. When the driver
installation task is completed, continue following the prompts until the operating system is
successfully installed.

● RHEL 6: Insert your HP driver disc. The HPIKL installation software automatically starts. Follow
the prompts to install the contents.

Warranty

As part of the HP workstation hardware warranty, HP provides software configuration and installation
support for certified versions of Red Hat Linux for up to 90 days from date of purchase.
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Setting up SUSE Linux Enterprise Desktop (SLED)
HP offers a 64-bit SLED 11 preload on some Z series Workstations and supports 64-bit SLED 11 on
other workstations.

Various versions of SLED are certified and supported by SUSE on HP workstations. For more
information, refer to the SUSE certification bulletin search page at http://developer.novell.com/
yessearch.

Setting up preloaded SLED

To set up SLED on systems preloaded with the operating system:

1. Start the workstation.

2. When prompted, enter the workstation installation settings: password, network, graphics, time,
keyboard settings, and SUSE Customer Center Configuration.

NOTE: You can activate your SUSE subscription from the SUSE Customer Center Configuration
screen. To view the full SUSE Customer Center documentation, go to http://www.suse.com/
documentation and select your operating system.

Installing SLED with the DVD Installer Kit

1. If an HP driver disc did not come with your workstation, create one (see HP Installer Kit for Linux
(HPIKL) on page 45.

2. Install the operating system using the discs included in the SUSE box-set.

3. After successfully installing the operating system, reboot the workstation.

4. Insert your HP driver disc. The HPIKL installation software automatically starts. Follow the prompts
to install the contents.

Warranty

HP provides configuration and installation support for SLED 11 on Z series Workstations for up to 90
days from date of purchase. SUSE also provides support for all versions of SLED that are certified on HP
workstations.
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Restoring SLED (preloaded systems only)

The SLED restore media is required to restore the Linux operating system. To create restore media:

1. Click the SUSE ISO icon on the desktop to go to the /iso folder. This folder contains all iso images
used to preload your workstation.

2. Follow the instructions in the readme file in this folder to copy the ISO image file onto optical
media.

3. Store the media in a safe place. If your workstation experiences a hard drive failure, use the ISO
recovery images tor restore your operating system.

CAUTION: Restoring the operating system does not restore data. Back up your data using the
method and media of your choice.

Proprietary graphics drivers
Most HP workstations can be ordered with graphics cards that have been through extensive verification
by HP. See the Hardware Support Matrix for HP Linux Workstations at http://www.hp.com/support/
linux_hardware_matrix for a list of supported cards.

NOTE: Not all graphics cards are available on every workstation. Limitations generally occur for
cards that consume large amounts of power in lower-power workstations.

Proprietary graphics drivers supported by HP and the graphics vendors are available with the HP
Installer Kit for Linux, with the SLED 11 preload on Z series Workstations, and from HP Workstation
Support at http://www.hp.com/go/workstationsupport.

These proprietary drivers are not a standard part of the RHEL or SLED distributions because they are not
open source. Driver revisions more recent than those at the HP support website are supported directly
by the vendor.
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7 Updating the workstation

HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and software
updates on a regular basis.

Updating the workstation after first boot
After successfully booting the workstation for the first time, you should follow these guidelines to ensure
that the workstation is up-to-date:

● Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 49.

● Ensure that you have the latest drivers for your system. See Upgrading device drivers
on page 50.

● Become familiar with your available HP resources.

● Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS
For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.

Determining the current BIOS version

To determine the current BIOS version:

1. Press Esc during power-up.

2. Press F10 to enter the F10 Setup utility.

3. Select File > System Information. Note the workstation BIOS version and compare it with the
BIOS versions that appear on the HP website.

NOTE: For procedures for upgrading the BIOS as well as the F10 Setup utility BIOS Menu
settings are located in the Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.
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Upgrading BIOS

To find and download the latest available BIOS, which includes the latest enhancements:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to locate the latest BIOS available for the workstation.

4. If the BIOS on the website is the same as the version on your system, no further action is required.

5. If the BIOS on the website is a version later than the one on your system, download the
appropriate version for the workstation. Follow the instructions in the release notes to complete the
installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you
have the latest device drivers loaded. If you purchased your device through HP, visit the HP website to
download the latest drivers for your device. These drivers have been tested to ensure the best
compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP website first to see if your
device and its drivers have been tested for HP workstation compatibility. If no driver is available, visit
the device manufacturer's website to download the latest drivers.

To upgrade device drivers:

1. Go to http://www.hp.com/go/workstationsupport.

2. Under Tasks in the left column, select Download Drivers and Software.

3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the website of the manufacturer of the peripheral device.
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8 Diagnostics and Minor
Troubleshooting

Calling support
At times you might encounter an issue that requires support. When you call support:

● Have the computer readily accessible.

● Write down the computer serial numbers, product numbers, model names, and model numbers
and have them in front of you.

● Note any applicable error messages.

● Note any add-on options.

● Note the operating system.

● Note any third-party hardware or software.

● Note the details of any blinking LEDs on the front of the computer (tower and desktop
configurations) or on the side of the computer (all-in-one configurations).

● Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the product number (example:
PS988AV) of the computer. If the computer has a product number, it is generally located next to the 10-
or 12-digit serial number of the computer.

NOTE: On most models, the serial number and product number labels can be found on the top or
side panel and at the rear of the computer (tower and desktop configurations) or on a pull-out card on
the side of the display (all-in-one configurations).

For a listing of all worldwide support phone numbers, go to http://www.hp.com/support, select your
region, and click Connect with HP in the upper-right corner.
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Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each
computer.

● All workstations have a serial number (unique for each workstation) and product number. Have
these numbers available when you contact support.

● The Certificate of Authentication (COA) is used for Windows 7-preinstalled systems only.

● The Genuine Microsoft Label (GML) is used for Windows 8-preinstalled systems only.

● A service label shows the build ID and Feature Byte strings, which are needed for system board
replacement.

In general, these labels can be found in the top, rear, or bottom of the chassis (tower and desktop
configuration) (your computer might look different).

Figure 8-1  Tower and desktop label locations

Locating warranty information
To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack
Services offer upgraded service levels to extend and expand a standard product warranty.

HP troubleshooting resources and tools
This section provides information on HP Support Assistant (HPSA), online support, and helpful hints for
troubleshooting.
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HP Support Assistant (HPSA)

HPSA, which is available on select workstations running Windows 7, helps you maintain workstation
performance and resolve problems. HPSA provides automated updates, onboard diagnostics, product
information, and guided assistance to help maintain optimum workstation performance. To access
HPSA, click Start > All Programs > HP Help and Support > HP Support Assistant.

NOTE: HP Support Assistant is not available on Linux or Windows 8.

Online support

Online access and support resources include web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.

The following websites are also available to you:

● http://www.hp.com — useful product information

● http://www.hp.com/support/workstation_manuals— the latest online documentation

● http://www.hp.com/go/workstationsupport — technical support information for workstations

● http://welcome.hp.com/country/us/en/wwcontact_us.html — worldwide support: chat with a
technician, obtain email support, find support numbers, or locate an HP service center

● http://www.hp.com/support/workstation_swdrivers — software and drivers for workstations
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Troubleshooting a problem

To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with the workstation, complete the following:

1. Visit http://www.hp.com/go/workstationsupport.

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.

3. Under Select your product (center window), select Workstations (under personal
computing).

4. Under Select your product, continue with selections as appropriate to the workstation series
and model, and to the problem you are troubleshooting.

Instant Support and Active Chat

HPSA is a set of web-based support tools that automate and speed up the resolution of problems
concerning desktop computing, tape storage, and printing.

Active Chat enables you to electronically submit a support ticket to HP over the Internet. When you
submit a support ticket, Active Chat collects information about the computer and passes it to an online
support specialist. The collection of information might take up to 30 seconds, depending on the
computer configuration. When you submit a support ticket, you receive a confirmation message
containing your case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, go to
http://instantsupport.hp.com/.

NOTE: This feature is not available on Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices

To find advisories, bulletins, and notices:

1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. Under Resources for <your selected product>, select See more….

4. Under Self-Help resources: in the center of the window, choose the desired action and
appropriate information in the scroll list to view the index.

Product Change Notifications

Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a
30 to 60 day window of the manufacturing process change date. PCNs give customers advanced
notice of changes to their product, such as an updated BIOS version. The latest PCNs are located at:
http://www.hp.com/go/workstationsupport. Select your product, and then under Resources for the
HP Workstation, click See more.
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Helpful hints

If you encounter a problem with the workstation, monitor, or software, the following general
suggestions might help you isolate and focus on the problem before taking further action.

At startup

● Verify that the workstation and monitor are plugged into a working electrical outlet.

● Remove all optical discs and USB drive keys from the drives before powering on the workstation.

● Verify that the workstation is turned on and the power light is on.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

● Verify that the monitor is turned on and the green monitor light is on.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If the workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary VGA adapter. During startup, the other monitor
connectors are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).

During operation

● Look for blinking LEDs on the workstation. The blinking lights are error codes that will help you
diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section in the
Maintenance and Service Guide for your workstation for information on interpreting diagnostic
lights and audible codes.

● Press and hold any key. If the system beeps, your keyboard is operating correctly.

● Check all cables for loose or incorrect connections.

● Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

● Reconfigure the workstation after installing a non–plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

● Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

● If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

● If you recently installed new software, uninstall the software and verify if the workstation functions
properly.
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● If the monitor connected to a tower, desktop or all-in-one computer is blank:

◦ Plug the monitor into a different video port on the computer if one is available. Alternatively,
replace the monitor with a monitor that you know is working properly.

◦ Verify that the computer and monitor are plugged into a working electrical outlet.

◦ Verify that the monitor is turned on and the green monitor light is on.

◦ Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If the internal display on an all-in-one computer is blank, open the computer and make sure the
graphics card is properly installed.

● Upgrade the BIOS. A new release of the BIOS might have been released that supports new
features or fixes your problem.

● For more detailed information, see the troubleshooting chapter in the Maintenance and Service
Guide at http://www.hp.com/support/workstation_manuals.

Customer self repair

Under the Customer self repair program, you can order a replacement part and install the part without
onsite HP technical assistance. Customer self repair may be required for some components. See
http://www.hp.com/go/selfrepair for information on the program.

NOTE: Some components are not eligible for customer self-repair and must be returned to HP for
service. Call HP Support for further instructions before attempting to remove or repair these
components.

Other troubleshooting options

The following additional troubleshooting techniques and tools are located in the Maintenance and
Service Guide at http://www.hp.com/support/workstation_manuals:

● POST Error Codes

● Diagnostic LEDs and audible beep codes

● Troubleshooting scenarios and solutions

● HP Vision Diagnostics (Z420, Z620, Z820)

● HP PC Hardware Diagnostics (Z220 SFF and Z220 CMT)
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9 Routine Care

General cleaning safety precautions
● Never use solvents or flammable solutions to clean the computer.

● Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

● Always unplug the computer before cleaning the keyboard, mouse, or air vents.

● Always disconnect the keyboard before cleaning it.

● Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the chassis
● Follow the safety precautions in the Maintenance and Service Guide for your workstation before

cleaning the computer.

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol
evaporates quickly and does not leave a residue.

● After cleaning, always wipe the computer with a clean, lint-free cloth.

● Occasionally, clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.
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Cleaning the keyboard
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

● If the keyboard has an on/off switch, turn it off.

● Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.

● Visible debris underneath or between the keys can be removed by vacuuming or shaking.

● Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key remover to prevent damage to the keys. This
tool is available from many electronic supply outlets.

CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.

● Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful
not to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

● Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
● Follow the safety precautions in the Maintenance and Service Guide for your workstation before

cleaning the computer.

● To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or a
clean cloth moistened with water.

CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may
result.
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Cleaning the mouse
1. Follow the safety precautions in the Maintenance and Service Guide for your workstation before

cleaning the computer.

2. If the mouse has an on/off switch, turn it off.

3. Wipe the body of the mouse with a damp cloth.

4. If the mouse has a:

● Laser or LED: use a cotton swab dampened with cleaning solution to gently brush out any
dust around the laser or LED, then wipe again with a dry swab. Do not wipe the laser or LED
directly with the swab.

● Scroll wheel: spray canned, pressurized air in the gap between the scroll wheel and the click
buttons. Do not blow air directly on one spot for very long or condensation can form.

● Roller ball: remove and clean the roller ball, remove any debris from the ball socket, wipe out
the socket with a dry cloth, and reassemble the mouse.
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